WORD PROCESSING |

Overview
Word processing skills are necessary in today's world. This event recognizes FBLA members who
demonstrate that they have acquired entry-level skills for word processing positions in businass.

This event consists of two parts: an objective test taken at the NLC and a skills production test taken prior
to the NLC.

This event is only for grades 9 and 10.

Competencies and Task Lists
http:f/www.fbla-pbl.orq/docs/ct/FBLA/WORDPROCESSINGI.Ddf

Web Site Resources
e Business Education Links
hitp:/ilessonplans.btskinner.com/
e FGCU Word 2007 Tutorial
httD:/’/www.chu.edu!suDoorﬂoﬁiceZOO?I\Nord/index,asp
e Microsoft Word XP/2003 Tutorial
hitp:/iwww. baveongroup.com/wlessond.htm

WORD PROCESSING | SAMPLE QUESTIONS

1. The toolbar that contains buttons that can quickly apply such things as bold, italics, bullets, and
paragraph alignment is called the:
a. Formatting toolbar
b. Task Panel
c. Menu Bar
d. Standard toclbar

2. Which button on the Standard toolbar is used to copy character formatting already applied to text to
different locations in the document?

a. paste
b. copy
c. drawing

d. format Painter

3. Which word is spelled incorrectly?
a. acknowledgement
b. appearance
c. anilysis

4. Which word is spelled incorrectly?
a. imediately
b. management
¢. maintenance
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5. Which word is spelled incorrectly?

a. privelege
b. passed
C. paid

6. Which word is spelled incorrectly?
a.” cooperation
b. coarse
c. competible

7. Torun a macro, use all but one of the following methods:
a. use an assigned keyboard shoricut
b. Tools, Macros, and Run
C. use an assigned toolbar button
d. Tools, Macro, Macros, select macro desired, and click run

8. To move to a previous cell in a table press the:
a. Shift+Tab
b. Tab
c. Backspace
d. Control + Backspace

9. Select the number of punctuation, capitalization, and grammar errors in the following sentence:
Jean arrived in San Francisco California on wednesday June 27.
a. 1

B B
c. 2
d 0

10. On the horizontal ruler, an upside down T indicates a tab stop.
a. decimal-aligned
b. right-aligned
¢c. centered

d. left-aligned
11. A(n) is an example of an AutoShape.
a. index
b. callout
c. canvas
d. toolbar

12. A on the first page of a newsletter may consist, for example, of the information about the
multiple columns of the newsletter,
a. table of contents
b. headline
c. nameplate
d

subhead

13. Select the number of punctuation, capitalization, and number errors in the following sentence:
Elin gave $300,000,000 fo charity; our gift was only 75 cents.
2

1
0
3

20T
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14. To insert a document into an open Word document, click:
a. Insert File on the Format menu
b. File on the Insert menu
c. the Insert File button on the Standard toolbar
d. Insert on the File menu

15. When using the find and replace feature to replace text that is uppercase, you should choose which
option?

a. use wild cards

b. find whole words only

C. Uppercase only

d. match case

16. Ori the works cited page of an MLA style report, list works by each author's last name and
the title of the work.
a. underline or boldface
b. boldface or italicize
c. enlarge or underline
d. italicize or underline

17. The refers to the shape of the characters in a document.
a. font
b. fontsize
c. design
d. style
18, a word selects the entire paragraph, including the paragraph mark.
a. Double-clicking
b. Left-clicking

¢. Triple-clicking
d. Right-clicking

19. Which word processing view is useful for formatting documents that will be viewed on a computer
screen or a browser?
a. Print Layout
b. Normal
c. , Outline
d. Web Layout

20. Which one of the following words is spelied incorrectly?

a. ageism

b. singeing

c. sincerely
d. morigageor

21. Which one of the following is the correct way to type a date in the return address of a lettar?
a. 2/15/2010
b. 2-15-10
c. Feb. 15,2010
d. February 15, 2010

22. Which sentence is correct?
a. Fewer receptionists are available now than before.
b. Less engineer are unemployed today.
c. Fewer receptionists is available now than before,
d. Lessengineers is unemployed today.
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23.

24,

25,

26,

27.

28,

29.

30.

By default, pressing TAB indents the first line of a paragraph by how much?
a. one-halfinch

b. , three-quarters of an inch

c. one-quarter inch

d. one inch

Which one of the following is not true of shading?
a. shading does not print

b. shading can be applied to words or paragraphs
c. shading can be a pattern

d. shading can be a color

In mail merge terminology, all of the information about one person or object is called a:
a. field

b. source document

c. main document

d. record

When the insertion point is located in the last cell in a table, what happens when you press the Tab
key?

a. The insertion point moves to the beginning of the table.

b. The insertion point moves to the end of the cell.

c. A new row is created at the bottom of the table.

d. The insertion point moves to the beginning of the row.

Text that appears at the top of every page in a document is called a:

a. " heading
b. footer
c. title

d. header

Which feature would you use to close all open documents and exit the software program?
a. close button on the document window

b. close Window button in the File menu

c. close button on the title bar

d. exit command in the File menu

You are printing several copies of a letter on company letterhead, but the text is running on top of the
letterhead. What should you do?

a. adjust the top margin

b. use plain paper instead of letterhead

c. print on longer paper

d. adjustthe page width

What does a green wavy line under a word indicate?
a. a possible spelling error

b. an AutoCorrect adjustment

c. an AutoComplete adjustment

d. a possible grammar error
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WORD PROCESSING | PRODUCTION TEST

JOB 1: Business Letter with Dot-leader Table

Key the following business letter with a dot-leader table according to the guidelines in the FBLA-PBL
Format Guide. Use the current date. The lstter is addressed to Mr. and Mrs. Jonathan Strong, 1519 South
Fourth Avenue, Salem, OR 99023. The letter is from Erank Truman, Travel Agent. The subject line is
TRAVEL RESERVATIONS. Additional instructions will be shown in parentheses. Do not type what is
inside the parentheses. Supply all necessary letter parts.

Hotel reservations for your trip to the Hawaiian Islands have been finalized. As you requested, 2/l hotel
reservations have been made at Grand Palace Hotels. Reservations have been confirmed for the
following dates:

(Type the following as a 2 column, 4 row table using dot leaders between the columns. The table should
be 1.5 inches in from the left and right margins.)

Maui Grand Palace December 4-8
Grand Palace Resort December 9-12
Grand Palace Seaside December 13-15
Honolulu Grand Palace December 16-18

fIYour airline reservations have not been confirmed. | am still waiting for a reduction in price. | have heard
that airlines will be lowering their rates during the next two weeks. As soon as the airfare is reduced
below $800, | will make your flight reservations. § Will you need a car while you are vacationing in
Hawaii? Please let me know if you would like me to reserve a car for you at each island. | am enclosing a
copy of your confirmation numbers for the hotel reservations.

Print Job 1 Print business letter with dot-leader table.
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JOB 2: Unbound Report with Bulleted List and Header

Defining Newsletter Elements (Title/Main Heading)
Designing a Newsletter (Side Heading)

{IThe demand for newsletters in the private and business sectors has helped to promote the desktop
publishing revolution. Affordable word processing and desktop publishing software, along with laser
printers, significantly reduced the cost of producing professional-quality newsletters. Now users with
limited budgets can create multiple page documents in-house providing organizations, businesses, or
individuals with a cost-effective means of communicating. ] Newsletters are one of the most common
means of communicating information and ideas to other people. Newsletters may be published by
individuals, associations, clubs, churches, schools, businesses, consultants, service organizations,
political organizations, government offices, and other organizations all over the world. 1 Designing a
newsletter may appear to be a simple task, but newsletters are more complex than they appear.
Newsletters may be the ultimate test of your desktop publishing skills. Remember that your goal is to get
the message across. Design is important because it increases the overall appeal of your newsletters, but
content is still the most important consideration. Whether your purpose for creating a nawsletter is to
develop better communication within your company or to develop awareness of a product or service, your
newsletter must give the appearance of being well planned, orderly, and consistent. To establish
consistency from one issue of a newsletter to the next, carefully plan your document. 9

Defining Basic Newsletter Elements (Side Heading)

Successful newsletters contain consistent elements in every issue. Basic newsletter elements divide the
newsletter into organized sections to help the reader understand the text, as well as entice the reader to
continue reading. Basic newsletter elements include the following: q

(Double space between each bulleted item)

* Nameplate: The nameplate, or banner, consists of the newsletter's title and is usually located cn
the front page. Nameplates may include a logo, a unique typeface, or a graphics element to heip
create or reinforce a company identity.

* Logo: A graphic symbol of a company.

» Subtitle: A subtitle is a short phrase describing the purpose or audience of the newsletter, A
subtitle also may be called a tag line. The information in the subtitle is usually located belcw the
nameplate near the folio.

» Folio: Afoliois the publication information including the volume, issue number, and current date
of the newsletter.

» Headlines: Headlines are titles to articles that are frequently created to attract the reader's
attention. The heading may be set in 36- to 72-point type or larger and is generally keyed in a

sans serif typeface. _
» Subheads: Subheads are secondary headings that provide the transition from headlines to body

copy. Subheads break up the text into organized sections.

» “ Byline: The byline identifies the author of the article.

» Body Copy: The main part of the newsletter is the body copy or text.

+ Graphics Images: Graphics images are added to newsletters to help stimulate ideas and add
interest to the document. They provide visual clues and visual relief to text-intensive COPpY.

Print Job 2 Print unbound report with bulleted list and header.
JOB 3: Memo with Bulleted List (15 points)
Key the following memo according to the guidelines in the FBLA-PBL Format Guide. The names of the

textbooks should be in italics. The items in parentheses are additional instructions. Use the current dqte.
The memo is to All Teaching Staff, and is from Christy Edmonds, the subject is Business Communication

Books.
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The library has recently purchased several reference books on business communications. These books

are now available at the library. The books that are available include:

(Double space between each bulleted itemn)

* The ABC's of Business Communications written by Leonard T. Nicoletta and published by

Sacramento Publishing House.

» Communications for the Business Office by Stacy Keating and published by Hubler & Tate.
» Basics of Business Communications by Darrell Talmadge and published by Fifth Avenue

Publishers.

o Communicating with Style by Clara Blakely and published by Moon Bay Publishing. §]

You may want to use these reference books for your business communications classes. Students may

also want to use them for preparing documents or writing reports.
Print Job 3 Print memo with bulleted list.

JOB 4: Outline

Key the following outline according the FBLA-PBL Format Guide.

The Internet (Main Title)

(Lével 1)What is the Internet?

(Level 1)The History of the Internet
(Level 2) APRANet
(Level 2) Design of APRANet
(Level 2) Growth of the Internet
(Level 2} Birth of the Web

(Level 1) Connecting to the Internet
(Level 2) Types of Internet Connections
(Level 2) Using 2 Browser
(Level 2) Plug-ins

(Level 1) Finding Information on the Web
(Level 2) Access Speed
(Level 2) Domain Names and URLS
(Level 2) Using Internet Directories and Search Engines

(Level 1) Web Site Creation and Programming
(Level 2) Crezting a Web Site
(Level 2) Programming for the Web

Print Job 4 Print outline.
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JOB 5: Table without Gridlines

Key the following data into a three-column table without gridlines. Center the table horizontally and
vertically on the page. Single space the body of the table.

MANORWOOD SCHOOL DISTRICT (Title of Table)
Enroliment Comparisons (Secondary Title)
School 2006 2007 (Column Headings, add a shaded fill to this row)

Meeker Senior High 1,160 1,033
Rollings Senior High 890 993
Lakeview Middle School 690 587
Oakridge Middle School 681 801
Cedar Middle School 702 745
Stewart Elementary 521 498
Overman Elementary 386 404
Grand Elementary 478 512
Curtiss Elementary 403 455

Print Job 5 Print tabie without gridlines.

="¢m%“.
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WORD PROCESSING Il PRODUCTION TEST

JOB 1: Memo

Key the following memo in accordance with the FBLA-PBL Format Guide. The memo is to Southeast
Chocolate Employees from Ed Shaw, Manager. Use the current date, and the subject is New
Promotional ltems. Supply all necessary memo parts. Use the following paragraphs for the body of the
memo.

jlSoutheast Chocolate is proud to roll out its new line of confectionary products. This product line is
named “Ones” and consists of eight new chocolate and chocolate-infused flavored candies.

The new promotion entitled, “One Bite and You're Hooked," will begin in Miami, Fiorida, on September 1,
2010, and will go nationwide on October 1, 2010. We are proud to announce that James Woodsville will
be the front pitchman for our advertisement campaign. As you know, James has been with the company
since the beginning and has made a name for himself by his philanthropy and community involvement.
We are thrilled to have him on boeard!

fiThe new product line features new flavors, such as cherry-chocolate, jalapefio-dark chocolate, and even
an orange-chocolate blend. This new product line not only tastes great, but also is great for communities.
In fact, five percent of every product sold will be donated to local communities for park renovations and
other kid-friendly projects.

{We afe encouraging all employees to help Southeast Chocolate by thinking about new products that
consumers may like. A bonus of $500 will be awarded to ideas that are approved.

Print Job 1 Print memo.

JOB 2: Table without Gridlines

Key the following information in a table without gridlines following the FBLA-PEL Format Guide. The title
is Stock Portfolio Performance from the financial department.

Net Current 52 Week
Company Exchange Chanae Price Hi/Lo
E TRADE NAS $-0.32 $4.96 26.08/3.46
SPDR TR ASE 30.04 314717 18024 136:7h
CITIGROUP NYS $-0.36 $31.93 57.00/29.75
MICROSOFT NAS $-0.22 $33.48 37.50/2660
EMC CORP NYS $0.43 $10.54 254711274

Print Job 2 Print table without gridlines.
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JOB 3: Mail Merge Letter

Key the following letter in accordance with the FBLA-PBL Format Guide. The salutation of each letter
should include "Dear” and be followed by the parent’s name(s) of the student you are concerned with.
The student’s name should be included in the first sentence after the text ‘Our records indicate that”. The
letter is from Karen Brown, 4th grade teacher. Supply all necessary letter parts; use the current date.
New paragraphs are indicated with ] symbols.

Use the following names and addresses for the letters:

Parents: Mr. & Mrs. Smith
Student: Johnny Smith
Address: 14533 Lakeshore Avenus
Omaha, NE 60018
Parents: Mr. & Mrs. Brooks
Student: Adrian Brooks
Address: 15643 Oceanview Drive
Cmaha, NE 60018
Parents: Mr. & Mrs. Hernandez
Student: Rosa Hernandez
Address; 123 Main
Omaha, NE 60019
Parents: Ms. Wong
Student; Laura Wong
Address: 13942 Maple Street

Omaha, NE 60020
Body:”

Our records indicate that «Student» hasn'’t returned the permission slip for our class field trip to the zoo.
The field trip is September 9, and we plan to leave school at 8 a.m. and return at 3 p.m. Please be sure to
send the permission slip to school no later than September 2. You can call the school at 555-1212 or e-
mail me at kbrown@thisschool.edu if you have any questions.

Print Job 3-A  Print one copy of the letter showing the merge fields,
Print Job 3-B  Print each of the merged letters.
Print Job 3-C  Print a copy of the data source.
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JOB 4: Table of Contents

Format the following Table of Contents in accordance with the FBLA-PBL Format Guide. Include dot
leaders, and be sure that the page numbers are right-aligned.

Introduction
Web Page Design Basics 2
What is HTML? :
Creating Web Pages from Scratch
Hardware and Software Needed 5
Saving Web Pages
Viewing Web Pages Locally 8
Browser Compatibility
Current Browsers 10
Browser Differences 12
Web Page Compatibility 14
Troubleshooting
FAQ 15
Contact Information 19
Viewing Web Pages on the Internet
Uploading Files 21
Viewing the Web Site 25

[(9)]

Print Job 4 Print table of contents.

JOB 5: ltinerary

Create the following itinerary in accordance with the FBLA-PBL Format Guide. The itinerary is for Mr.
Alan Perlman for the dates December 9—1 1, 2010.

Tuesday, December 9

3:20 p.m. Depart OMA - Omaha Eppley Airfield, Midwest Flight 945, nonstop to DCA, Ronald
Reagan Washington International Airport.
5:00 p.m. Arrive DCA Airport, claim baggage, and take taxi outside baggage claim area for

transport to Embassy Suites; reservation confirmed.

6:00 p.m. Meet and greet with clients in the Embassy Suite lounge.
8:00 p.m. Dinner reservations at Embassy hotel restaurant.
Wednesday, December 10

7:30 a.m. Breakfast at hotel restaurant.

8:30 a.m. New Product Demonstration in Room 115.

11:00 a.m. Question and Answer Session in Room 118.

12:00 p.m. Open Lunch.

1:00 p.m. Taxi to Senate building to visit with state senators.
3:00 p. m. Open for sightseeing.

Thursday, December 11

7:30 a.m. Breakfast at hotel restaurant.

8:30 a.m. Advertising Promotion Meeting in Room 120.
11:00 a.m. Depart Convention Center for airport.

1:00 p.m. Return Midwest Airlines Flight 45, nonstop to OMA.
4:35 p.m. Arrive OMA— Omaha Eppley Airfield.

Print Job 5 Print itinerary.
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JOB 6: Agenda
Key the following agenda in accordance with the FBLA-PBL Format Guide.

NORTH UNIVERSITY

Educational services committee

Vice President of Academic Affairs Agenda
September 29, 2010

Call to order — Hammer, Vice President

Roll Call - Ziemba

Old Business — Smith

Committee Report — Background Checks for Education Students — Jacksen
Committee Report — Statewide Student Services Meeting Summary — Brown
Committee Report — Statewide Distance Learning Meeting Summary — Jones
Special Topics — Dart

Excellence in Learning — Jones

: New Business

0. Next Meeting

1L Adjournment

SO ND O AW N

Print Job 6 Print agenda.

JOB 7: Personal Letter

Key the following letter in accordance with the FBLA-PBL Format Guide. The letter is to the Dinnerware
Factory — Warranty Department frem Craig Brooks.

Dinnerware Factory
24887 Dinnerware Road
Charleston, SC 29554

Craig Brooks
1665 West Jones Road
Denver, CO 68973

| am including 12 plates that we purchased from Dinnerware three years ago. We were told when we
purchased them that the plates came with a lifetime guarantee. As you can see, the plates have not held
up well under average usage. | am requesting that the plates be replaced.

fWe really enjoy Dinnerware and appreciate anything you can do to remedy the situation. Please e-mail
at chrooks@mvyhotmail.com or call me at 800-555-5555 with any questions you might have,

Sincerely
Craig Brooks

Print Job 7 Print personal letter.
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WORD PROCESSING | PRODUCTION ANSWER KEY

JOB 1: Business Letter with Dot-leader Tahle
2" Top Margin

Current Date

Mr. and Mrs. Jonathan Strong
1619 South Fourth Avenue
Salem, OR 89023

Dear Mr. and Mrs. Strong
TRAVEL RESERVATIONS
Hotel reservations for your trip to the Hawaiian Islands have been finalized. As you requested, all hotel

reservations have been made at Grand Palace Hotels. Reservations have been confirmed for the
following dates:

Maui Grand Palace.............cc.oocooovoveeooooooo December 4-8
Grend Palage RESHT.... .o g December 8—12
Grand Palace Seaside ..o December 13-15
Honolulu Grand Palace ..o December 16-18

Your airline reservations have not been confirmed. | am stil walting for a reduction in price. | have heard
that airlines will be lowering their rates during the next two weeks. As soon as the airfare is reduced
below $600, | will make your flight reservations.

Will you need a car while you are vacationing in Hawaii? Please let me know if you would like me to
reserve a car for you at each island. | am enclosing a copy of your confirmation numbers for the hotel
reservations.

Sincerely yours

Frank Truman
Travel Agent

je

Enclosure
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JOB 2: Unbound Report with Bulleted List and Header
2” Top, 1” Side

DEFINING NEWSLETTER ELEMENTS

Designing a Newsletter

The demand for newsletters in the private and business sectors has helped to
promote the desktop publishing revolution. Affordable word processing and deskfop
publishing software, along with laser printers, significantly reduced the cost of producing
professional-quality newsletters. Now users with limited budgets can create multiple
page documents in-house, providing organizations, businesses, or individuals with a
Cost—e—;ﬁective means of communicating.

Newsletters are one of the most common means of communicating information
and ideas to other people. Newsletters may be published by individuals, associations,
clubs, churches, schools, businesses, consultants, service organizations, political
organizations, government offices, and other organizations all over the world.

Designing a newsletter may appear to be a simple task, but newsletters are more
complex than they appear. Newsletters may be the ultimate test of your desktop
publishing skills. Remember that your goal is to get the message across. Design is
important because it increases the overall appeal of your newsletters, but content is still
the most important consideration. Whether your purpose for creating a newsletter is to
develop better communication within your company or to develop awareness of g
product or service, your newsletter must give the appearance of being well planned,
orderly, and consistent. To establish consistency from one issue of a newsletter to the

next, carefully plan your document.
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Defining Basic Newsletter Elements

Successful newsletters contain consistent elements in every issue. Basic

newsletter elements divide the newsletter into organized sections to help the reader

understand the text, as well as entice the reader to continue reading. Basic newsletter

elements include the following:

Nameplate: The nameplate, or banner, consists of the newsletter's title and is
usually located on the front page. Nameplates may include a logo, a unique
typeface, or a graphics element to help create or reinforce a company identity.

Logo: A graphic symbol of a company.

Subtitle: A subtitle is a short phrase describing the purpose or audience of the
newsletter. A subtitle also may be called a tag line. The information in the subtitle
is usually located below the nameplate near the folio.

Folio: A folio is the publication information including the volume, issue number,
and current date of the newsletter.

 Headlines: Headlines are titles to articles that are frequently created to attract the

reader’'s attention. The heading may be set in 36- to 72-point type or larger and is
generally keyed in a sans serif typeface.

Subheads: Subheads are secondary headings that provide the transition from
headlines to body copy. Subheads break up the text into organized sections.

Byline: The byline identifies the author of the article.
Body Copy: The main part of the newsletter is the body copy or text.

Graphic Images: Graphic images are added to newsletters to help stimulate
ideas and add interest to the document. They provide visual clues and visual
relief to text-intensive copy.
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JOB 3: Memo
2” top margin

TO: All Teaching Staff
FROM: Christy Edmonds
DATE: Current Date

SUBJECT: Business Communication Books

The library has recently purchased several reference books on business
communications. These books are now available at the library. The books that are
available include:

» The ABCs of Business Communications written by Leonard T. Nicoletta and
published by Sacramento Publishing House.

o Communications for the Business Office by Stacy Keating and published by
Hubler & Tate.

o Basics of Business Communications by Darrell Talmadge and published by Fifth
Avenue Publishers.

o Communicating with Style by Clara Blakely and published by Moon Bay
Publishing.

You may want to use these reference books for your business communications classes.
Students may also want to use them for preparing documents or writing reports.

XX
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JOB 4: Outline
2” Top Margin
THE INTERNET

l. WHAT IS THE INTERNET?
Il. THE HISTORY OF THE INTERNET

APRANet

Design of APRANet
Growth of the Internet
Birth of the Web

O 0Ow

1. CONNECTING TO THE INTERNET

A. Types of Internet Connections
B. Using a Browser
C. Plug-ins

V. FINDING INFORMATION ON THE WEB

A. Access Speed
B. Domain Names and URLs
C. Using Internet Directories and Search Engines

V. WEB SITE CREATION AND PROGRAMMING

A. Creating a Web Site
B. Programming for the Web
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JOB 5: Table
MANORWOOD SCHOOL DISTRICT

Enroliment Comparisons

Schooli /- 7 e H9ED006 147 2007
Meeker Senior High 1,160 1,033
Rollings Senior High 890 993
Lakeview Middle School 690 587
Oakridge Middle School 681 801
Cedar Middle School 702 745
Stewart Elementary 921 498
Overman Elementary 386 404
Grand Elementary 478 512
Curtiss Elementary 403 455
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WORD PROCESSING Il PRODUCTION ANSWER KEY

JOB 1: Memo
2” Top Margin

T Southeast Chocolate Employees
FROM: Ed Shaw, Manager

DATE: Current Date

SUBJECT: New Promotional ltems

Southeast Chocolate is proud to roll out its new line of confectionary products, This
product line is named, “Ones” and consists of eight new chocolate and chocolate-
infused flavored candies.

The new promotion entitled, “One Bite and You're Hooked,” will begin in Miami, Florida,
on September 1, 2010 and will go nationwide on October 1, 2010. We are proud to
announce that James Woodsville will be the front pitch-man for our advertisement
campaign. As you know, James has been with the company since the beginning and
has made a name for himself by his philanthropy and community involvement. We are
thrilled to have him on board!

The new product line features new flavors, such as cherry-chocolate, jalapefio-dark
chocolate, and even an orange-chocolate blend. This new product line not only tastes
great, but it also is great for communities. In fact, five percent of every product sold will
be donated to local communities for park renovations and other kid-friendly projects.

We are encouraging all employees to help Southeast Chocolate by thinking about new
products that consumers may like. A bonus of $500 will be awarded to ideas that are
approved.

XX
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JOB 2: Table without Gridlines
STOCK PORTFOLIO PERFORMANCE

Financial Department

Net Current 52 Week
Company Exchange Change Price Hi/Lo
E TRADE NAS -0.32 4.96 26.08 (348
SPDR TR ASE 0.04 147 .17 157.52 £ 138 .75
CITIGROUP NYS -0.36 31.93 57:00/29.75
MICROSOFT NAS -0.22 33.48 375072660
EMCCORP NYS 0.43 19.54 2547 /12.74

JOB 3! Mail Merge
Job 3-A.: Master, field names may vary

Current Date

«AddressBlock» may vary
Dear «Parents»

Our records indicate that «Student» hasn't returned the permission slip for our class
field trip to the zoo. The field trip is September 9, and we plan to leave school at 8 a.m.
and return at 3 p.m. Please be sure to send the permission slip to school no later than
September 2. You can call the school at 555-1212 or e-mail me at
kbrown@thisschool.edu if you have any questions.

Sincerely

Karen Brown
4" Grade Teacher
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Job 3-B: Merged Letters (4) Sample of Letter 1

Current Date

Mr. & Mrs. Smith
14533 Lakeshore Ave
Omaha, NE 60018

Dear Mr. & Mrs. Smith

Our records indicate that Johnny Smith hasn't returned the permission slip for our class
field trip to the zoo. The field trip is September 9, and we plan to leave school at 8 a.m.
and return at 3 p.m. Please be sure to send the permission slip to school no later than
September 2. You can call the school at 555-1212 or e-mail me at
kbrown@thisschool.edu if you have any questions.

Sincerely

Karen Brown
4" Grade Teacher

JOB 3-C: Data Source

4" Grade Student Address City State | Zip
TeacherParents

Mr. & Mrs. Smith | Johnny Smith | 14533 Lakeshore Ave Omaha | NE 60018
Mr. & Mrs. | Rosa 123 Main Omaha | NE 60019
Hernandez Hernandez

Mr. & Mrs. Adrian Brooks | 15643 Oceanview Drive | Omaha | NE 68818
Broocks

Mrs. Wong Laura Wong 13942 Maple Street Omaha | NE 68820
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JOB 4: Table of Contents
2" Top Margin

TABLE OF CONTENTS

Introduction

Web Page Design BasiCS .........ooooiiiiiviiieeee,
Vhal 18 FITHIL P s it shentbmuardmameiinesmmrmelodimahndpsnatie
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JOB ! ltinerary
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ITINERARY
Alan Perlman

December 9-11, 2010

Tuesday, December 9

3:20 p.m.

5:00 p.m.

6:00 p.m.

8:00 p.m.

Depart OMA—Omaha Eppley Airfield, Midwest Flight 945, nonstop to
DCA, Ronald Reagan Washington International Airport.

Arrive DCA Airport, claim baggage, and take taxi outside baggage claim
area for transport to Embassy Suites, reservation confirmed.

Meet and greet with clients in the Embassy Suite lounge.

Dinner reservations at Embassy hotel restaurant.

Wedn:esday, December 10

7:30 a.m.
8:30 a.m.
11:00 a.m.
12:00 p.m.
1:00 p.m.

300 p. m.

Breakfast at hotel restaurant.

New Product Demonstration in Room 115.
Question and Answer Session in Roomn 118.
Open Lunch.

Taxi to Senate building to visit with state senators.

Open for sightseeing.

Thursday, December 11

7:30 a.m.
8:30 a.m.
11:00 a.m.
1:00 p.m.

4:35 p.m.

Breakfast at hotel restaurant.

Advertising Promction Meeting in Room 120.
Depart Convention Center for airport.

Return Midwest Airlines Flight 45, nonstop to OMA.

Arrive OM—Omaha Eppley Airfield.
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JOB 6: Agenda
May have the 2" line of heading as a subtitle

NORTH UNIVERSITY
EDUCATIONAL SERVICES COMMITTEE

Vice President of Academic Affairs Agenda

September 29, 2010

1. Call to order—Hammer, Vice President
2. Roll Call—Ziemba

3. Old Business—Smith

4, Committee Report

Background Checks for Education Students—Jackson
State Wide Student Services Meeting Summary—Brown
State Wide Distance Learning Meeting Summary—Jones

N Special Topics—Dart

B. Excellence in Learning—Jones
7. New Business

8. Next Meeting

9. Adjournment
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JOB 7: Personal Letter

1665 W Jones Road
Denver, CO 68973
August 1, 2010

Dinnerware Factory
24887 Dinnerware Road
Charleston, SC 29554

Dear Warranty Department or Dear Sir or Madam

| am including 12 plates that we purchased from Dinnerware three years ago. We were told
when we purchased them that the plates came with a lifetime guarantee. As you can see, the
plates have not held up well under average usage. | am requesting that the plates be replaced.

We really enjoy Dinnerware and appreciate anything you can do to remedy the situation.
Please e-mail at cbrooks@mvyhotmail.com or call me at 800-555-5555 with any questions you
might have.

Sincerely

Craig Brocks
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